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Chapter 1. Introduction
1. License agreement
Read this license agreement thoroughly before using the Software. Using and copying this Software is subject to
the acceptance of this agreement.

If you choose to refuse the following conditions, please return this Software to the point of purchase for a complete
refund. This agreement involves Tecnosoft srl, Peschiera Borromeo, Milano, Italy (henceforth called Tecnosoft)
and the User (be it a physical or juridical person) for the following software products (henceforth called Software):

• "Resolvigen 4" and any software product accompanying it.

Tecnosoft grants the user a non-exclusive right to use a copy of the software on a single computer provided that
the user accepts the following conditions.

1. User license. The Software is property of Tecnosoft and cannot be copied nor sold without the prior written au-
thorization of Tecnosoft. The Software is protected by Italian and European Laws and by International Treaties
concerning intellectual properties.

2. Additional licenses. The purchase of additional licenses conveys the right to use the Software on a correspond-
ing number of computers at the same time.

3. Exclusion of liabilities. Except for what stated by applicable laws, in no case can Tecnosoft be considered liable
for damages or losses, direct or indirect, including, but not limited to, loss or missing income, suspension of
activities, loss of information or any other monetary or economical damage, deriving from proper or improper
use of the Software even if Tecnosoft has been advised of the possibility of such damages. In any case, the
responsibility of Tecnosoft for such damages will be limited to the price paid for the Software. This clause is
applied even if the User does not accept the Software.

4. Use of Software results. It is User's responsibility to check that results given by the Software are correct and
appropriate. In no case the Software should be used if such use can be threatening to the health or life of human
beings. This clause is applied even if the User does not accept the Software.

5. Updates. If the Software is an update of a previous version, the license is transferred from the old version to
the update. Only the update can be used, unless the update is destroyed.

6. Separation of components. The Software is licensed as a single product. Components cannot be separated.

7. Limitations. The User cannot convert, decode, decompile or disassemble the Software, except for what is ex-
plicitly requested by applicable laws.

2. How to get support
Resolvigen 4 is distributed by Ortho-Clinical Diagnostics:

Table 1.1. Ortho-Clinical Diagnostics

Australia Ortho-Clinical Diagnostics Australia Pty Ltd
8 Nexus Court, Nexus Corporate Park, Mulgrave
VIC 3170
Australia

Benelux Ortho Clinical Diagnostics
Parklaan 22, bus 10
2300 Turnhout, Belgium
Email: orders.be@orthoclinicaldiagnostics.com
Phone Flanders: 014 600 301
Phone Wallonia: 014 600 303

France Ortho Clinical Diagnostics



How to get support

2

8, rue Rouget de Lisle
CS60066
92442 Issy les Moulineaux cedex
France

Germany Ortho-Clinical Diagnostics GmbH
Bahnhofstrasse 54
D-69151 Neckargemünd
Germany

Italy Italy Ortho Clinical Diagnostics
Viale Fulvio Testi, 280
20126 Milano, Italy
Phone 0284220300
Fax 0284220392

Korea Ortho-Clinical Diagnostics Singapore Pte. Ltd. Korea Branch Office
3rd Floor, Hangangdaero 366, Yongsangu,
Seoul, South Korea (Dongjadong, Twincitiy Namsan)

Philippines Ortho-Clinical Diagnostics Philippines Inc.
4th Floor, Five E-Com Center, Unit 404-P,
Pacific Drive, Pasay City, Manila
Philippines

Portugal Ortho Clinical Diagnostics Portugal Unipessoal, Lda.
Lagoas Park - Edificio 5, Torre B, Piso 2
2740-245 Porto Salvo
PORTUGAL
Phone: +351 210961108

Singapore Ortho-Clinical Diagnostics Singapore Pte Ltd
The Synergy, 1 International Business Park,
Units #01 11/12, Singapore 609917

Spain Ortho Clinical Diagnostics
Avenida Partenón 10, 3# planta.
Campo de las Naciones
28042 Madrid
Fax:+34 918312005
Phone: +34 912992418

Thailand Ortho-Clinical Diagnostics (Thailand) Lrd
Interlink Tower, 1858/149, 1858/11, Bangna-Trad Rd,
Bangna, Bangkok 10260
Thailand

United-Kingdom Ortho Clinical Diagnostics
Jubilee House
Third Avenue
Globe Park
Marlow
Buckinghamshire
SL7 1YW
Phone: +44 (0) 1628 485122
Fax: +44 (0) 1628 487493
Email: ocduk@orthoclinicaldiagnostics.com

Trained product specialists are ready to answer your questions

Table 1.2. Ortho-Clinical Diagnostics: Technical support

Austria 0 810 001189 ocdtechsupport-de@orthoclinicaldiagnostic-
s.com
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BeNeLux (Belgium French speaking) 0800 17 528

BeNeLux (Belgium Dutch speaking) 0 800 17 963 bnlhotline@orthoclinicaldiagnostics.com

BeNeLux (The Netherlands) 0 800 02 23 579 bnlhotline@orthoclinicaldiagnostics.com

BeNeLux (Luxembourg) 800 222 738 bnlhotline@orthoclinicaldiagnostics.com

France 03 88 65 47 33 hotlinefrance@orthoclinicaldiagnostics.com

Germany 0 800 181 48 97 ocdtechsupport-de@orthoclinicaldiagnostic-
s.com

Irish Republic 00 800 08372560 ukhotline@orthoclinicaldiagnostics.com

Italy 800 870 655 italianhl@orthoclinicaldiagnostics.com

Nordic 00 800 08372560 nordichotline@orthoclinicaldiagnostics.com

Poland (support by Diasorin Pologne) +48 22 223 62 65 service_pl@pl.diasorin.com

Portugal 800 83 31 43 port_ocdhotline@orthoclinicaldiagnostics.com

Spain 900 973 325 spanishhotline@orthoclinicaldiagnostics.com

Switzerland 0 800 820120 SwissHotline@orthoclinicaldiagnostics.com

UK 0 800 895 963 ukhotline@orthoclinicaldiagnostics.com

Resolvigen 4 is a product of Tecnosoft srl. You can get support from the Resolvigen Internet site:

www.resolvigen.com

Or by mail at:

<software@resolvigen.com> (for software related questions)

<diagnostics@resolvigen.com> (for immunohematology related questions)

3. Colophon
The core functionality of Resolvigen 4 is the identification of antibodies directed against RBC antigens. The design
of this function builds on years of experience gained with Resolvigen 2 and Resolvigen 3, and further extends
both sensitivity and number of antibodies examined.

Resolvigen 3 extended the analysis of scores to identify antibodies in complex mixes and included procedures to
aid the identification of antibodies directed against high frequency antigens.

Resolvigen 4 improves on both these areas and procedures for identification of antibodies against public antigens
have been updated capitalizing on the wealth of information that has recently become available. The on-line doc-
umentation has been extended accordingly and now includes about 300 antibodies; the documentation is linked to
the program so that a complete description for any antibody is just a click away.

The support functions of Resolvigen have also been improved:

• It is now possible to share data among different copies of Resolvigen 4 running on different computers using
a client-server database system.

• A standard format for the diagnosis allows exporting results to LIS (Laboratory Information System).

• Backup and restore functions have been integrated in Resolvigen: there is no need for an external tool.

• Reports can be customized

• A graphical explanation of the results can be displayed on panels.

http://www.resolvigen.com
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Chapter 2. Installation
1. Software installation
To install Resolvigen 4 insert the CD in the drive; if the installation does not start automatically, open the CD
folder on your Windows desktop and double click on the installation icon.

Figure 2.1. The installation icon

The four numbers in the filename are the version number of the Resolvigen 4 program; after the
first installation you will be able to upgrade to the latest available version selecting the +Help →
Update menu item.

The installation program will start and ask you to select the installation language; this is the language used for the
installation: Resolvigen 4 will always install all the available languages.

If a previous version of Resolvigen 4 is already installed on the computer, the installation procedure will ask if
you wish to upgrade the existing installation or install a new copy of Resolvigen 4 in a different directory.

Figure 2.2. Upgrade or install in a different folder

The first option is the default as there is usually no reason to keep two different versions of Resolvigen 4 on the
same computer.

At the end of the installation program a new icon will be available on your desktop.

Figure 2.3. The Resolvigen 4 icon

Insert the hardware protection key in any free USB port, wait a few seconds for the key to install and double click
on this icon to run Resolvigen 4.
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2. The hardware protection key

Resolvigen 4 comes with an hardware protection key; this key does not need installation: just plug it into a free
USB port of your PC and wait a few seconds for Windows to recognize it.

The key is used to store:

• The master password: this is the password of the user root; this user has the possibility to configure Resolvigen 4
and to manage other users.

• The scramble key: this key is used to encrypt user passwords.

All keys come with both master password and scramble key set to "RESOLVIGEN". You may decide to change
them:

1. Select +Access → Change user to login as root; the default password is "RESOLVIGEN". The status bar at
the bottom of the Resolvigen 4 window should become orange.

2. Select +Access → Change security setup to change security settings; Resolvigen 4 will display a page in
which you may enter the new password and data protection scramble key; you will have to enter the old pass-
word in the Access block and then enter the new password in the Access data block or the new scramble key
in the Data protection block. In both cases you will need to enter data twice before confirming it by clicking
the Change button in the same block.

In a networked installation, it is essential that all PCs connected to the same database share the same scramble
key, otherwise the passwords entered on one PC will not be recognized by other PCs.

3. Configuring the data store

Resolvigen 4 may be configured to store data either in the local file system or in a client-server database; the
latter option requires that a client-server database is configured by the system administrator and is useful in an
environment in which different users need to use Resolvigen 4 on different computers sharing the same database.

When storing data in your local file system, you must consider if it will always be used with the same login, that
is the same Windows user, or with different logins.

Windows may store user data in different locations:

• A user directory, that is a subdirectory of C:\USERS; this directory is different for any Windows user, that is: if
there are two users, say SALLY and JOE, the first will store her data in C:\USERS\SALLY and the second in C:
\USERS\JOE; as a consequence each one will only see her or his data and will be unable to see the data entered
when the other user is logged in the computer. This only applies to the case in which each user logs in with a
different Windows account: if everyone logs in with the same account, say GUEST, everyone will be able to
access user data in C:\USERS\GUEST.

• A directory different from any system or program directory: a directory used for this on most system is C:
\PROGRAMDATA; this is probably the ideal solution unless your system administrator has decided to disable such
directories.

When using a local database, it is preferable to use it for indexing, while storing data in dedicated subdirectories: a
local database tends to be more brittle than a client server database, and a simple power failure may cause a disaster.

Normally Resolvigen 4 stores data in five different subdirectories of a base RESOLVIGEN directory which may
be located either in the user directory or in the C:\PROGRAMDATA directory.

• RESOLVIGEN\PATIENTS: for storing data files for patients.
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• RESOLVIGEN\PANELS: for storing data files for diagnostic panels.

• RESOLVIGEN\RBCS: for storing data files for rare RBCs.

• RESOLVIGEN\TESTS: for storing data files for tests.

• RESOLVIGEN\USERS: for storing data files for users' access credentials.

The database used for indexing data is normally stored in the RESOLVIGEN directory.

To configure Resolvigen 4 storage select the +File → Configure menu option; in the File page configure the Data
folders entries:

Figure 2.4. Data folders configuration

The last folder in this group (namely the LIS folder) is the folder used to export results to the Laboratory Infor-
mation System.

Then select H2 as the database engine (MySQL is the engine used for the client-server configuration).

Figure 2.5. Database configuration

Resolvigen 4 will try to select a folder for storing the database tables automatically, but if you prefer you may
enter a different folder in the Server field.

Make sure that the Store data in external xml checkbox is checked; in a local database you may wish to leave
the Login and Password fields blank: this is absolutely not recommended with a client server database.

To test the database operation, click the Test link button: the icon at its left should become green.

4. Updating indexes

To update the indexes after changing the storage configuration, select the +File → Reindex files item.
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Figure 2.6. Reindexing the archives

Select the checkmarks as in the above image, make sure that the Create tables checkmark is selected, then click
the Reindex selected archives button.

When the operation is completed you may close this page clicking the Close button.
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Chapter 3. Getting started
Resolvigen 4 is a very advanced software package and as such it offers several different functions; this chapter
focuses on the more basic and commonly used features.

1. The main window
When Resolvigen 4 is started, the main window displays the content of the archives; four different archives are
used to store Panels, patients, RBCs and tests. Several icons are located in a bar just under the top menu; the first
four icons select the archive displayed in the main window, while the remaining icons are a shortcut for the most
commonly used operations.

Figure 3.1. The archive buttons

The active archive may be selected by clicking one of the four archive icons in the toolbar; the following archives
are used by Resolvigen 4:

• Panels archive: this archive contains the diagnostic panels used in Resolvigen 4; the Panels are normally down-
loaded from the Internet to be imported in Resolvigen 4; when performing a test, some panels will normally be
added to test data and reactions of patient's serum with each RBCs sample on panel will be marked.

• Patients' archive: this archive contains the personal data for each patient and the immunohematological charac-
teristics of his or her RBCs; self RBCs are essential in solving some tough antibody identification problems.

• RBCs archive: this archive contains data for different RBCs samples that may be used after Panels for antibody
identification. If data for frozen RBCs are stored in this archive, Resolvigen 4 will support in the search for the
correct RBCs sample to add to Panels or to use for an adsorption and elution process.

• Tests archive: this archive will contain data for all tests entered in Resolvigen 4; data may be entered manually
or imported directly from the Innova

A fifth archive containing data for users registered for using Resolvigen 4 is available; this archive
is available through the Access menu.

The active archive may also be selected through the corresponding items of the File menu.

When an archive is displayed in the main window, four buttons are available in the toolbar for editing the content
of the selected archive.

Figure 3.2. The editing buttons

These buttons allow you to:

• Add a new item to the archive: the type of item added, a Panel, a patient or an RBCs sample, depends on the
currently selected archive. For a new patient or a new RBCs sample, Resolvigen 4 will open a blank form; for
Panels it will open a form to select which Panels to import.
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• Delete the currently selected item or items.

• Edit the currently selected item.

• Select which items to display based on some search criteria, that depends on the types of the items listed,

When a patient is selected in the patients archive, two additional buttons are available, for managing patient's tests.

Figure 3.3. The new test and browse tests buttons

These buttons allow you to:

• Browse tests performed for the selected patient in the past.

• Enter data for a new test.

Finally four buttons are available to access the online manual.

Figure 3.4. The help system buttons

These buttons will open:

• The user manual.

• The antibody documentation: identification hints, serological characteristics, clinical significance and biblio-
graphic information is available for over 300 antibodies.

• Step by step instructions for 47 procedure are available.

• Context sensitive help for the current operation.

The name of the currently logged user is displayed at the right bottom corner of the main window.

Figure 3.5. The currently logged user

The user is initially set as guest; depending on your security settings this user may or may not be enabled to
perform various operations; double click on this label to login as a different user.

2. Importing Panels: step 1, download panels from In-
ternet.
Diagnostic panels are required for antibody identification; you may download panels from the www.eanti-
gram.com site.

After accessing the site with a browser (for example Microsoft Explorer):
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1. Select your country and language.

2. Login with the credentials that you have received from OCD

3. In the ORTHO PLUSSM Applications menu at the top select e-Antigram

The browser will display a page for selecting the Panels you need:

Figure 3.6. The Antigram selection page

After entering your search criteria, click Search; the browser will display a list of the Panels matching your request.

Figure 3.7. A list of Panels

You may download an Acrobat PDF printable file if you wish, for your reference; Resolvigen 4 needs the Anti-
gram® antigen profile DAT file, which may be downloaded by clicking the eAntigram icon in the row of the
desired Panel.

Figure 3.8. The eAntigram icon

You will then be requested to confirm that the selected Antigram is the desired one; click OK and save the file
in the desired location.

Antigrams for expired panels are removed from this site; so you should download antigrams before
the expiration date.

3. Importing Panels: step 2, import .DAT files.
Make sure that the Panels archive is selected in the main window; then click the Add icon; Resolvigen 4 will
display the Panel import window.
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in the topmost part of this window select the type of files you wish to import:

• Resolvigen 2: this is the type of distribution file used by Resolvigen 2

• Resolvigen XML: this is the XML compliant file format used by Resolvigen 3

• OCD files: this is the type of distribution file used by OCD, that can be downloaded directly from the eAnti-
gram.com site.

The next box shows the folder currently used for importing files; to change this folder click on the Change button.
Resolvigen 4 will display a folder selection window: select the desired folder and click Open. You may conve-
niently set the default for the import folder to match the folder in which you usually store files downloaded from
the Internet, so that files downloaded from eAntigram.com as described above are immediately available. The
default import folder may be set in the configuration page.

Just below a list of the panels of the selected type available in the selected folder is shown; by default all the listed
panels are selected. To select a single panel, click on it; to select a range of panels, click on the first one, then press
the shift key and click on the last; to select a different set of panels click on the first one, then press the Control
key and click on as many additional panels as desired. Click OK to import the selected Panels.

Click the Reload button if you have added files to the folder or for any reason the files in the selected folder have
changed.

Panels in OCD format are digitally signed; Resolvigen 4 stores certificates used for validating the
digital signature; these certificates are periodically replaced with new ones; if the certificates stored
in Resolvigen 4 are not up to date, it will be impossible to import new panels; in this case you will
need to update the certificates as described in Chapter 12, Section 4: Managing digital signature
certificates.

4. Adding a patient

Select the patients' table, then click on the Add button in the toolbar or select +Patients → Add patient to add
a new patient.

Resolvigen 4 will display a Patient data page which allows editing both the personal and the clinical data for a
new patient.

In the uppermost part of the window Personal data for the patient can be edited, including:

• Family name

• First name

• Middle name

• Birth date

• Birthplace

• Hospital code (PID)

In the top right part of the window the user can enter notes about the patient. Try to put as much information as
possible in the other fields and only use this free form field for data that does not fit anywhere else.

Close to the bottom of the window, in the group box named Clinical data the user can enter:

• ABO group: click on the drop-down list-box to display a list of the available groups and select the relevant one;
available groups include unknown (blank), O, A, A1, A2, B, AB, A1B, A2B and Oh (Bombay).
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• Race: click on the drop-down list-box to display the available races and select the relevant one; available races
include unknown (blank), Caucasian, Black and Asiatic; race is relevant for the different incidence of certain
antibodies for individuals of different races.

• Antigenic profile for patient's RBCs: refer to Chapter 9, Editing antigenic profile and reactivities for details.

When you are finished editing patient's data, click OK to add the new patient to archives or Cancel to dismiss
the dialog without saving any data.

5. Performing a test
Antibody identification tests are obviously the main focus of Resolvigen 4; several procedures are available within
the test framework, like identification of antibodies against public antigens, for example. The normal routine
operation anyway, will be entering data on a screening and an identification panel and asking Resolvigen 4 to
provide the most reasonable explanation for the observer reactions. The more advanced features are explained in
Chapter 8, Antibody identification tests.

Select a patient in the patients' page, then select +Patients → New antibody identification test or click the
antibody identification icon to open the page for a new test.

Figure 3.9. The antibody identification icon

The Antibody identification test window contains four group of items: Patient's data, Test data, List of tests
and Select new test.

The Patient's data group contains data identifying the patient whose sample is being tested.

The Test data group contains additional data to identify the test; these data may be used to distinguish different
tests performed for the same patient:

• Sample date: this field may be used to mark the date in which the sample was sampled.

• Test date: this is the date in which the test was created; this date can not be edited by the user.

• Test code: this code may be used to identify the test; it is normally different from the patient's code: the test
code should vary from test to test, while the patient's code should remain constant for a long time, possibly for
the lifetime of the patient.

The Select new test group items are used to select new items to be added into the List of tests. Different types
of items may be selected. Depending on the type of item selected further data may be required to identify the
specific object to use.

Select the item type in the Type list-box.

The more commonly used types are:

• Screening panels: SurgiScreen, BioVue Screen and Selectogen

• Identification panels: Panel A, Panel B, Panel C, BioVue Top, CNRGS France and EFS France

Since this is an identification procedure, you would probably have results from an identification panel by now,
but you would also have the results of the screening panels that was performed first; entering data also for the
screening panel, will supply Resolvigen 4 with more information useful for identifying the antibodies in mix.

In the Select new test group select the screening panel type in the Type field, then select the specific panel in the
list below. Click the Add button: the panel will be added in the List of tests on the left.
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By default expired panels will not be listed; in case you need to enter data for an expired panel, mark
the List expired panels check box.

In the same way you may add an identification panel to the List of tests.

You need now to add reaction scores to the panels; double click on a panel in the List of tests to display the
antigram; the look of the antigram closely resembles the printed version. On the right you may enter the scores:
identify the phase for the reaction on the top of the Test results area and enter results in the cells in that column
for each RBCs sample.

You may enter results using either the keyboard or the mouse:

• Using the keyboard: move to the cell in which you need to enter the score, using the arrow key (also the
Home,End,PgUpand PgDn keys work as expected) and type the key for the score:

Table 3.1. Reaction scores

Score Key

0 0

+/- -

1+ + or 1

2+ 2

3+ 3

4+ 4

Hemolized H or E

Unknown ?

Undefined SPACE

• Using the mouse: double click with the left mouse button on the cell in which you need to enter the score and
select the score from the popup list.

Figure 3.10. Selecting scores from a list

When you are finished entering the scores click the OK button.

You should enter results for all the panels, for all the test phases you have performed: Resolvigen 4 can cope with
missing data, but the more data are available, the better.

When you are finished, click the Diagnosis button; after a few seconds Resolvigen 4 will display a new page.
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Figure 3.11. The results page

In a list at the top left corned of the page, Resolvigen 4 lists all the possible mixes of antibodies that can justify
the observed reactions. Below appears a detailed description of the selected mix.

Depending on the data available, more mixes can be displayed; click on a mix to display a detailed description for it.

It is responsibility of the user to determine if a mix is the correct answer for the problem: Resolvigen 4
just suggests the more reasonable possibilities.

6. Printing

Two commands are available in the File menu to support printing: +File → Print list and +File → Print list
preview. These commands are used to obtain printouts of the currently displayed list: Panels, Patients, Rare RBCs
or Tests.

The Print list command will display a window for selecting a printer and configuring the printout parameters.
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Figure 3.12. The printer selection window

Clicking the Print button will generate a printout on the selected printer.

The Print list preview commands will generate a preview for the requested report.

Detailed printout
Two commands, Print details and Print details preview, are available in the menu for the currently displayed
items (Patients, Panels, Rare RBCs and Tests); these commands are used to print and preview reports for each
item that is currently selected in the main window; the exact form of the report depends on the customizable report
format.
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Chapter 4. Panels
Click on the Panels tab at the top of the window (or select Panels in the File menu).

The data area of Resolvigen 4 window will show a table view of the currently available panels with code, type
of panel and expiry date.

Figure 4.1. The Panels page

When the panels archive is selected, the Panels menu is displayed; this menu has items to perform various opera-
tions on panels; note that some operations require that some panel is selected in the table, so, if no item is selected,
they will be disabled. To make these menu items active, select one or more panels in the table by clicking on the
corresponding row.

The table will be empty if no panel has been loaded yet or if all loaded Panels have expired. Note that, by default,
Resolvigen 4 only displays valid panels. To show expired panels as well, uncheck the Valid Panels only checkmark
at the bottom of the page.

To order the list of panels according to a specific column, click on the title of the column; clicking a second time
reverses the order in which panels are listed.

1. Importing Panels
Click on the Add button in the toolbar or select +Panels → Import to show the Import Panels page; in the topmost
part of this page select the type of files you wish to import:

• Resolvigen 2: this is the type of distribution file used by Resolvigen 2

• Resolvigen XML: this is the XML file format natively used by  Resolvigen 3 and Resolvigen 4.

• OCD files: this is the type of distribution file used by OCD USA. Panels in this format may be downloaded
from the eAntigram.com Internet site.

The Import from folder area shows the folder currently used for importing files; to change this folder click on
the Change button.

Just below a list of the panels available in the selected folder is shown; by default all the listed panels are selected.
To select a single panel, click on it; to select a range of panels, click on the first one, then press the shift key and
click on the last; to select a different set of panels click on the first one, the press the Control key and click on
as many additional panels as desired. Click the Reload button if for any reason the files in the selected folder
have changed. In order to import OCD files, you must first load OCD digital signature certificates (see Change
Security Setup (Root Only) paragraph.
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Panels in OCD format are digitally signed; Resolvigen 4 stores certificates used for validating the
digital signature; these certificates are periodically replaced with new ones; if the certificates stored
in Resolvigen 4 are not up to date, it will be impossible to import new panels; in this case you will
need to update the certificates as described in Access and security settings.

2. Viewing a panel
In order to view details about a given panel, double click in the list or select it and then select +Panels → Show
panel.

Resolvigen 4 will display the Panel in the main page: at the top the panel type (SELECTOGEN®,
SURGISCREEN®, BioVue® Screen, Panel A, Panel B or Panel C), lot number, expiration date and notes; below
the antigram for the panel is displayed.

Figure 4.2. The Panel View page

Some BioVue® Screen panels distributed in Europe list antigenic expressions for MNS system anti-
gens in the MNSs order; for consistency, Resolvigen 4 always displays these antigens in the same
SsMN order used by all other OCD panels.

Click Close to dismiss this page.

3. Deleting a Panel
To remove one or more panels select the related rows in the main window, then select +Panels → Delete.

Figure 4.3. The delete Panels confirmation window

Resolvigen 4 will show a window asking you to confirm the requested operation; click Do delete to remove the
selected panels or Do not delete to abort the operation.
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a complete copy of all panels used for a given test are stored with that test, so even if a panel is
removed from the archives, it is still possible to browse the antigenic profile and reactivities for that
panel within the same test; anyway, it will not be possible to add that panel to a new or existing test.

4. Printing a panel
Select one or more panels in the main window, then click +Panels → Print item to print all the selected items.
Resolvigen 4 will display a standard print setup window: select the printer you wish to use and click OK. One page
will be printed for each selected item, including both the identification information and the Antigram.

If you wish to see a preview of the printout before printing, click +Panels → Print item preview.
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Chapter 5. Patients
Click on the Patients icon or select Patients in File menu.

The data area of Resolvigen 4 window will show a table view of patients with Name, date of Birth, Birthplace
and Nosographic.

Figure 5.1. The patients page

When the Patients archive is selected, the Patients menu is displayed; this menu has items to perform various
operations on patients; note that some operations require that some patient is selected in the table, so, if no item
is selected, they will be disabled. To make these menu items active, select one or more patients in the table by
clicking on the corresponding row.

1. Adding a new patient
Click on the Add button in the toolbar or select +Patients → Add to add a new patient.

Figure 5.2. The patient's edit page

In the uppermost part of the page Personal data for the patient can be edited, including:

• Family name

• First name

• Middle name

• Birth date
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• Birthplace

• Hospital code (PID)

In the top right part of the window the user can enter notes about the patient. Try to put as much information as
possible in the other fields and only use this free form field for data that does not fit anywhere else.

Close to the bottom of the page, in the group box named Clinical data the user can enter:

• ABO group: click on the drop-down list-box to display a list of the available groups and select the relevant one;
available groups include unknown (blank), O, A, A1, A2, B, AB, A1B, A2B and Oh (Bombay).

• Race: click on the drop-down list-box to display the available races and select the relevant one; available races
include unknown (blank), Caucasian, Black and Asiatic; race is relevant for the different incidence of certain
antibodies for individuals of different races.

• Antigenic profile for patient's RBCs: refer to Chapter 9, Editing antigenic profile and reactivities.

When you are finished editing patient's data, click OK to add the new patient to archives or Cancel to dismiss
the page without saving any data.

2. Edit Patient

In order to edit data for a patient, select the patient's row in the main window, then select +Patients → Edit patient
, or just double click on patient's row.

Resolvigen 4 will display the same Patient data page described in the Section 1, “Adding a new patient” paragraph,
only all fields will be preset with data stored for the selected patient. When you are finished editing a patient's
data, click OK to save changes or Cancel to dismiss the dialog without recording changes.

3. Delete Patient

To remove one or more patients from the archives select the related rows in the main window, then select +Patients

→ Delete Patient.

Resolvigen 4 will show a window asking you to confirm the requested operation. Click Do Delete to remove the
selected patients or Do Not Delete to abort the operation.

a complete copy of a patient's data is stored with test data when a test for a patient is performed; so,
even if a patient is removed from the archives, patient data is still stored with each stored test. When
opening an existing test for browsing, Resolvigen 4 will check for a matching patient:

• If a matching patient is found, Resolvigen 4 will compare and warn about any difference, offering
to copy test patient data to stored patient data or vice versa or to ignore differences.

• If no matching patient is found, Resolvigen 4 will offer to save the test patient data as a new patient.

Therefore, when exchanging data with other Resolvigen users, sending just the test XML file is
enough.

4. Select Patient View

Select +Patients → Select patient view or click the View button in the toolbar: Resolvigen 4 will display the
Select patients to view window.
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Figure 5.3. The Patients select view

In this window you can select to either display all patients or just patients with a given pattern of family name,
first name and middle name or birthdate.

For example, select With name like button and type “Brown”: Brown John, Brown Philip as well as Browning
Henry, will match. After selecting the display criteria for patients click Search to confirm or Cancel to revert
to the previous settings.

Once set, display criteria remain fixed until you decide to change them again; if a new patient is
added that does not match these criteria, it will not appear in the list in the main window, although
it will be added in the archives.

5. Antibody Identification
In order to perform a new antibody identification test for a patient, select patient's row in the main window, then
click the menu item +Patients → Antibody identification. Resolvigen 4 will display the Antibody identification
test window; the use of this window is described in detail in Chapter 8, Antibody identification tests.

6. Browse Tests for Patient
To browse tests performed on a given patient, select the patient's row in the main window, then click +Patients

→ Browse tests for patient.

Resolvigen 4 will display a window for selecting an existing test to browse or performing a new test.

Figure 5.4. The test selection window
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The uppermost part of the window displays a list of tests performed in the past for this patient. To browse one
of these tests select the Reopen stored test radio button, then select the specific test in the list; when a test is
selected a more detailed diagnosis is displayed below the list of tests; click the OK button to open the test.

To perform a new test, select the Create new test radio button and click OK.

After clicking OK, the Antibody identification test page will be displayed; the use of this page is described in
detail in Chapter 8, Antibody identification tests.

7. Importing patient's data
The Import and Export menu items are used together to exchange patients between different computers or users.

Select +Patients → Import to import patients from external XML files (e.g. from an USB key) into Resolvigen 4;
Resolvigen 4 will display the Import from XML files page.

Figure 5.5. The patients import page

At the top of this window the current import folder is displayed; to change it, click the Change button and select
a new folder in the window that will be displayed.

In the central part of the window a list shows all the XML patient files available in the current folder: select one
or more files and click the OK button. Click the Cancel button to dismiss this page without importing any file.

Resolvigen 4 will check the content of the files before displaying them in the Import From XML
files window: even if a file has .XML extension and is a valid XML file, it will not be listed if it
does not actually contain valid data for a patient.

8. Export patient's data
The Import and Export menu items are used together to exchange patients between different Resolvigen or users.

Select in the main window the patients you wish to export (one or more patients), then select +Patients → Export;
Resolvigen 4 will display the Confirm XML export page.
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Figure 5.6. The export patients page

At the top of this window the current export folder is displayed; to change it click the Change button and select
a new folder in the window that will be displayed. Click Export to export XML files for selected items or Do
not export to abort operation.

Make sure that the Export personal data option at the bottom of the window is not checked if you
do not wish to export personal data.

You may send the data by email by clicking Send by email; Resolvigen 4 will ask for the recipient email address.

The email server must be set before sending email: enter the configuration page, selecting +File →
Configure and set parameters as described in Chapter 10, Section 7: Email configuration.

9. Printing patients reports
Select +Patients → Print in the Patients menu to print all the selected patients.

The printout will include both personal and clinical data for the patient.

Resolvigen 4 will display a print setup window analogous to the print setup window described in the section File
– Print . One or more pages will be printed for each selected patient, depending on the configured print layout,
including both personal and clinical data.

Select a patient in the main window, then click the +Patients → Print preview item to display a preview for a
printout for the selected patient.
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Chapter 6. RBCs
Click on the RBCs icon at the top of the window (or select +File → Rare RBCs).

The data area of Resolvigen 4 window will show a table view of RBCs with donor's Code, Name, date of Birth
and list of stored Samples.

Figure 6.1. The RBCs page

When the RBCs archive is selected, the Rare RBCs menu is displayed; this menu has items to perform various
operations on RBCs; note that some operations require that some RBC is selected in the table, so, if no item is
selected, they will be disabled. To make these menu items active, select one or more RBCs in the table by clicking
on the corresponding row.

1. Adding a new RBCs
Click on the Add button in the toolbar or select +Rare RBCs → Add RBC to add a new RBC donor; Resolvigen 4
will display a RBC page which allows editing both personal data for the new donor and RBC immunohematological
characteristics.

Figure 6.2. The RBCs edit page

In the group-box in the top left part of the window, you can edit donor's personal data, including:

• Family name

• First name
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• Middle name

• Birth date

• Donor's code

• Origin: should identify where donor's RBCs can be obtained, like a blood bank or reference laboratory.

• Address

• Phone

In the top right part of the window a notes field can be used to record user notes that do not fit in other fields
in this window.

Just below, the Samples box displays a list of the available samples; a single dash is displayed if no sample is
available.

To edit the list of samples click on the '...' button on the right of the sample list; Resolvigen 4 will display the
List of RBC samples dialog.

Figure 6.3. The sample list window

This dialog shows a list of currently available samples in the Samples box: this list will be empty for a new donor.

To add a new sample to this list click the Add button, then:

• Click the left mouse button in the Code column field and type the sample code: this is normally different from
the donor's code.

• Click the left mouse button in the Date column field; Resolvigen 4 will preset this field with the current date;
edit it if you need to enter a different date.

• Click the left mouse button in the Quantity field and type the quantity of available samples: generally this should
be the number of available frozen test tubes.

To remove an existing sample, e.g. when a sample has been completely used, select it in the list and click the
Remove button.

When you are done with editing the samples list, click OK to confirm changes; a list of sample codes will be
displayed in the Samples box in RBC data window. Click Cancel instead to drop changes.

In the bottom part of the RBC page, a RBC data group-box contains immunohematological data for the RBC;
the following data can be inserted:

• ABO group: click on the drop-down list-box to display a list of the available groups and select the relevant one;
available groups include unknown (blank) O, A, A1, A2, B, AB, A1B, A2B and 0h (Bombay).
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• Race: click on the drop-down list-box to display the available races and select the relevant one; available races
include unknown (blank), Caucasian, Black and Asiatic.

• Cord: check this box if the RBC sample is a cord sample.

• Antigenic profile for donor's RBCs: refer to Chapter 9, Editing antigenic profile and reactivities.

When you are finished editing the RBC donor data, click OK to add the new donor to archives or Cancel to dismiss
the dialog without saving any data.

2. Editing an RBC sample
In order to edit data for an RBC donor, select donor's row in the main window, then click +Rare RBCs → Edit
RBCs, or just double click on donor's row. Resolvigen 4 will display the same RBC data window described in
Section 1, “Adding a new RBCs”, only all fields will be preset with the data stored for the selected RBC donor.

When you are finished editing the donor's data, click OK to save changes or Cancel to dismiss the dialog without
saving changes.

3. Deleting an RBC sample
To remove one or more RBCs from archives select the relevant rows in the main window, then select +Rare RBCs

→ Delete RBC.

Resolvigen 4 will show a window asking you to confirm the requested operation; click Do Delete to remove the
selected RBCs or Do Not Delete to abort the operation.

Complete copies of all RBCs used for a given test are stored with that test; so, even if an RBC is
removed from archives, it is still possible to browse antigenic profile and reactivities for that RBC
within the same test. In any case, it will not be possible to add that RBC to a new or existing test.

4. Selecting RBCs to list
Select +Rare RBCs → RBC view or click the View/Order button in the toolbar; Resolvigen 4 will display the
Select RBC view window.

Figure 6.4. The RBC filter window

You can choose to display all donors or just donors with a specific antigenic profile; in the latter case you should
also specify as much of the profile as needed: double click on any antigram cell and select the desired antigenic
expression for the antigen; set any antigenic expression to blank if you don't care about it: donors with any antigenic
expression for an antigen left blank will be accepted.
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You can also select the required ABO compatibility (most likely this should be set to the ABO group of the patient
being examined):

• O: only O donors will be accepted

• A: only O and A (both A1 and A2) donors will be accepted

• B: only O and B donors will be accepted

• AB: all donors will be accepted

After selecting the display criteria for donors click Search to confirm or Cancel to revert to the previous settings.

Once set, display criteria remain fixed until you decide to change them again. If a new donor is added
that does not match these criteria, it will not appear in the list in the main window, although it will
be added in the archive.

5. Importing RBCs data
The Import and Export menu items are used together to exchange RBCs between different computers or users.

Select +Rare RBCs → Import to import RBCs from external XML files (e.g. from an USB key) into Resolvigen 4;
Resolvigen 4 will display the Import from XML files page.

Figure 6.5. The Import RBCs page

At the top of this page the current import folder is displayed; to change it click the Change button and select a
new folder in the window that will be displayed.

In the central part of the window a list shows all the XML RBCs files available in the current folder: select one or
more files and click the OK button. Click the Cancel button to dismiss this page without importing any file.

Resolvigen 4 will check the content of the files before displaying them in the Import From XML
files window: even if a file has .XML extension and is a valid XML file, it will not be listed if it does
not actually contain valid data for an RBC sample.



Exporting RBCs data

31

6. Exporting RBCs data
The Import and Export menu items are used together to exchange RBCs between different computers or users.

Select in the main window the RBCs you wish to export (one or more RBCs), then select +Rare RBCs → Export;
Resolvigen 4 will display the Confirm XML export window.

Figure 6.6. The export RBCs page

At the top of this page the current export folder is displayed; to change it click the Change button and select a
new folder in the window that will be displayed. Click Export to export XML files for selected items or Do not
export to abort operation.

Make sure that the Export personal data option at the bottom of the window is not checked if you
do not wish to export personal data.

You may sent the data by email by clicking Send by email; Resolvigen 4 will ask for the recipient email address.

The email server must be set before sending email: enter the configuration page, selecting +File →
Configure and setting parameters as described in Chapter 10, Section 7: Email configuration.

7. Printing RBC reports
Select one or more RBCs in the main window, then SELECT +Rare RBCs → Print to print all the selected RBCs.

Resolvigen 4 will display a print setup window analogous to the print setup window described in the section File –
Print. One or more pages will be printed for each selected RBC sample, depending on the configured print layout,
including both donor's and clinical data.

Select an RBCs sample in the main window, then select +Rare RBCs → Print preview to display a preview for
a printout of the selected sample.
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Chapter 7. Tests
Click on the Tests icon at the top of the window (or select +File → Tests).

The data area of Resolvigen 4 window will show a table view of tests with patient's Name, date of Birth, PID
and Date of Test.

Figure 7.1. The Tests page

When the test archive is selected, the Tests menu is displayed; this menu has items to perform various operations
on tests; note that some operations require that some test is selected in the table, so, if no item is selected, they will
be disabled. To make these menu items active, select one or more tests in the table by clicking on the corresponding
row.

1. Editing a Test
In order to browse or edit data for a test performed in the past, select test row in the main window, then select
+Tests → Edit test, or just double click the test row.

When opening an existing test Resolvigen 4 compares the data for the patient stored in test with the same patient
in patients' archive and it will show a window if any difference is found.

Figure 7.2. Discrepancies between test and patient
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You may choose:

• Copy information from patient in archive into the test being opened.

• Copy information from test being opened to current patient.

• Ignore the differences and continue opening the test

This window is only shown if there are discrepancies between test and patient.

At this point Resolvigen 4 will display the Antibody identification test window; the use of this window is described
in detail in Chapter 8, Antibody identification tests.

To perform a new test switch to patients' archive, select a patient, then select +Patients → Antibody
identification.

2. Deleting a test
To remove one or more tests from archives select the related rows in the main window, then select +Tests →
Delete Test.

Resolvigen 4 will show a window asking you to confirm the requested operation; click Do Delete to remove the
selected tests or Do Not Delete to abort the operation.

3. Selecting tests to list
Select +Tests → Select test view or click the View/Order button in the toolbar; Resolvigen 4 will display the
Select tests to view window.

Figure 7.3. The Select tests to view window

Tests can be filtered on different conditions; more that one condition can be set at the same time: Resolvigen 4
will only show tests matching all conditions set.

The uppermost group-box, Patient name, can be used to filter patient's name: you can choose either to display tests
for all patients or just for patients with a given pattern of family name, first name and middle name. For example,
check With name like button and enter 'Brown': Brown John, Brown Philip as well as Browning Henry, will match.
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The next group-box, Test date, can be used to filter only tests performed during a given range of dates: check
Dates in range button and enter both dates for start and end of period; date format depends on country.

The next group-box, Sample date, can be used to filter only tests performed on samples taken in a given range of
dates: check Dates in range button and enter both dates for start and end of period.

After selecting the display criteria for tests click OK to confirm or Cancel to revert to previous settings.

Once set, display criteria remain fixed until you decide to change them again; if a new test is added
that does not match these criteria, it will not appear in the list in the main window, although it will
be added in the archive.

4. Importing tests
The Import and Export menu items are used together to exchange tests between different computers or users.

Select +Tests → Import to import tests from external XML files (e.g. from a USB memory) into Resolvigen 4;
Resolvigen 4 will display the Import from XML files page.

Figure 7.4. The import tests page

At the top of this page the current import folder is displayed; to change it click the Change button and select a
new folder in the window that will be displayed.

In the central part of the window a list shows all the XML test files available in the current folder: select one or
more files and click the OK button. Click the Cancel button to dismiss this dialog without importing any file.

Resolvigen 4 will check the content of the files before displaying them in the Import from XML files
window: even if a file has .XML extension and is a valid XML file, it will not be listed if it does
not actually contain valid data for a test.

5. Exporting tests
The Import and Export menu items are used together to exchange tests between different computers or users.
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Select in main window the tests you wish to export (one or more tests), then click +Tests → Export; Resolvigen 4
will display the Confirm XML export window.

Figure 7.5. The export test page

At the top of this window the current export folder is displayed; to change it click the Change button and select
a new folder in the window that will be displayed.

Click Export to export XML files for selected items or Do not export to abort operation.

Make sure that the Export personal data option at the bottom of the window is not checked if you
do not wish to export personal data.

You may send the data by email by clicking Send by email; Resolvigen 4 will ask for the recipient email address

The email server must be set before sending email: enter the configuration page, selecting +File →
Configure and setting parameters as described in Chapter 10, Section 7: Email configuration.

6. Printing test reports
Select one or more tests in main window, then select +Tests → Print to print all the selected tests.

Resolvigen 4 will display a print setup window; select the desired printer, then press the OK button; one or more
pages will be printed for each selected test, depending on the configured print layout, including all data entered
for the test: patient's data, panel data, reactivities and notes entered by user.

Select a test sample in the main window, then +Tests → Print preview to display a preview for a printout of
the selected test.
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Chapter 8. Antibody identification
tests
All antibody identification related tasks are reached through the Antibody identification test page and sub-win-
dows opened by this page.

Antibody identification page may be opened:

• by selecting Antibody identification in the Patients menu

• by selecting Edit test in the Tests menu

• by double clicking on row in the main window when tests are displayed

1. Antibody Identification Test Window

The Antibody identification test window contains four group of items: Patient's data, Test data, List of tests
and Select new test.

Figure 8.1. The patient's data

The Patient's data group contains data identifying the patient whose sample is being tested.

Figure 8.2. The test data

The Test data group contains additional data to identify the test; these data may be used to distinguish different
tests performed for the same patient:

• Sample date: this field may be used to mark the date in which the sample was sampled.

• Test date: this is the date in which the test was created; this date can not be edited by the user.

• Test code: this code may be used to identify the test; it is normally different from the patient's code: the test
code should vary from test to test, while the patient's code should remain constant for a long time, possibly for
the lifetime of the patient.
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Figure 8.3. The test selection group

Items in Select new test group are used to select new items to be added into the List of test list. Different types of
items may be selected. Depending on the type of item selected further data may be required to identify the specific
object to use. Select the item type in the Type list-box.

Selecting SURGISCREEN®, SELECTOGEN®, BioVue® Screen,
Panel A, Panel B or Panel C or other panels

When one of these item types is selected, a list of available items is displayed. Normally only valid panels are
displayed. To list expired panels, check the List expired panels check box. You can either select one of the listed
items, or directly type the panel code in the Item field.

Selecting Self RBCs

No additional data is needed in this case.

Selecting Rare RBCs

When this item type is selected, a list of RBCs is displayed; this list normally contains the complete list of RBCs
in archives; click the Select RBCs profile button to filter RBCs for a given profile; Resolvigen 4 will display the
same dialog described in Chapter 6, Section 4: Selecting RBCs to list. You can either select one of the listed items,
or directly type the RBC code in the Item field.

Selecting Rare Antibodies Test

No additional data is required; a test for the identification of antibodies against high frequency antigens will be
added.

Selecting List of Excluded Antibodies

No additional data is required; this item is used to exclude some antibodies from the search, in case for some reason
those antibodies are known not to be present in the patient's serum. Please note that the most obvious reason for
excluding antibodies, namely the presence of the related antigen on non reacting patient's RBCs, is better expressed
by adding the patient's RBCs to the test and marking the negative scores for reactions.

The presence of an antigen on patient's RBCs is not enough to exclude an antibody targeting the
antigen: Resolvigen 4 will consider the possibility of an autoantibody.
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Editing the List of Tests

When the desired item is selected click the Add button to add it to the List of tests.

Figure 8.4. The list of tests

To remove one item from the List of tests, select it in the list and click the Delete button. Deleting a test item
also removes all data entered in it.

All items in the List of tests should be filled with data from tests. To edit one item, select it in the List of tests,
and click the Edit button or just double click on the item.

Entering results in Antigrams

Data in screening and identification panels, as well as self RBCs and rare RBCs, are edited via an Antigram like
interface; data can be entered here as described in Chapter 9, Editing antigenic profile and reactivities.

Only reactivities can be edited. When patient's RBCs have been added to the test, a row for them is appended at
the bottom of each antigram. For this row, the antigenic profile may also be edited.

Editing list of Excluded Antibodies

In some circumstances you may wish to exclude some antibodies from search; the most common case is that of
non-reacting patient's RBCs expressing an antigen targeted by the given antibody.

Figure 8.5. The antibody exclusion page

In this specific case, the best way of proceeding would be to add patient's RBCs, enter antigenic profile and mark
scores.

In some rare cases this may not be enough; for example a D+ patient can still develop and anti-D alloantibody
(patient with a D partial phenotype).
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In some circumstances some antibodies may be excluded from search for different reasons. In these cases, you
may wish to explicitly exclude antibodies; after adding an Exclude antibodies item, double click on the item in
the List of tests.

Antibodies excluded from the search are crossed in this window. To tag or untag an antibody, double click on it.
Click OK to update list of excluded antibodies or Cancel to dismiss this page without saving.

2. Editing Rare Antibodies Test
In some cases, all panels RBCs are reactive. This may be due to a complex mix of antibodies in serum or to the
presence of a single antibody against a common antigen.

The first case can usually be detected by the strong difference of reactivities with different test RBCs. Resolvigen 4
will generally suggest different mixes that have the more strongly reacting antibodies in common and give hints
on how to proceed to identify other antibodies in mix (e.g. by adsorption/elution).

In the second case, it is impossible to proceed further with panels: even high frequency reactive antibodies directed
against high frequency antigens on panels (namely k, Kpb, Jsb and Lub) are hard to detect (by dose effect or by
typing of patient's RBCs), but for the vast majority of antibodies against high frequency antigens you get practically
no hint at all from panels.

In these cases, you may wish to perform a rare antibodies test; after adding a Rare antibodies test item, double
click on the item in the List of tests. The initial page for Antibodies against high frequency antigens search will
be displayed. This page gives some initial directions about the tests to perform.

Figure 8.6. Rare antibodies: preliminary operations

At the bottom of the window a few buttons are displayed:

• Back (<<): click this button to move to previous step; this button is initially disabled.

• Next (>>): click this button to move to next step after filling data eventually required in this step.

• Cancel: click this button to exit the rare antibodies identification procedure.

• OK: when procedure is complete, click this button to save data.

After preparing samples as described in this page, click the Next button; Resolvigen 4 will ask you to enter some
data.
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Figure 8.7. Rare antibodies: self and donor's RBCs

Fill in data and click the Next button. The path followed from now on depends on data entered step by step. A few
pages are displayed, some giving instructions on how to proceed with tests and some asking for data input.

Figure 8.8. Rare antibodies: list of possible antibodies

Depending on the observed characteristics of the antibody Resolvigen 4 asks to perform different tests.
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Figure 8.9. Rare antibodies: antibody behaviour

Which help narrow the list of possible antibodies.

Figure 8.10. Rare antibodies: suspected specificities

3. Viewing Results

Click the Diagnosis button in order to view the interpretation that Resolvigen 4 gives for entered data. Depending
on the complexity of the mix, the analysis may take some time; an hourglass cursor is displayed during analysis,
and a progress bar signals the completion of the process. At the end the Diagnosis page is displayed.
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Figure 8.11. List of possible mixes

At the top left of the window a list of possible mixes explaining the observed reactions is displayed; when selecting
one of these mixes, a detailed description is reported in the text area below.

Figure 8.12. Detailed description of selected mix

In "Mix fits data": not at all < badly < satisfactorily < well < perfectly;

In "Mix is": extremely rare < rare < not common < common < extremely common.

Still below, in Clinically significant antibodies not excluded, a list of the clinically significant antibodies whose
normal reaction pattern would be covered by observed reactivity is reported.

Figure 8.13. Clinically significant antibodies not excluded

On the right it is possible to enter a free form note at the top and enter a detailed diagnosis at the bottom.

The diagnosis is entered in a structured way that allows exporting the results in an ASTM compatible format to
a LIS.

Figure 8.14. Structured diagnosis

It is possible to fill the diagnosis from one of the possibilities suggested by Resolvigen 4: select the mix in the top
left box and click the import button at the bottom left of the Diagnosis box.

You may edit the diagnosis using the buttons at the bottom of the Diagnosis box; these buttons are used in order to:
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• Move the selected antibody up in the diagnosis list

• Move the selected antibody down in the diagnosis list

• Add a new antibody

• Remove the selected antibody

• Edit the selected antibody

When adding a new antibody, Resolvigen 4 first asks to select the antibody; by default the antibodies normally on
panels are listed; select a different item in Select group to list the antibodies for a given system.

Figure 8.15. Selecting an antibody for diagnosis

Click OK to display a window in which the characteristics of the identified antibody may be entered.

Figure 8.16. Entering antibody characteristics
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The last button at the right of the Diagnosis box will export the diagnosis in ASTM format.

H|\^&|||Resolvigen4|||||||P|1|20160506165210
P|1||12345|||Smith^John||19980422|U|C|^^^^||||||||||||||||||||||||
O|1||876^\^|^^^ABID^^|N|20160504000000|||||||||^^||||||||||F|||||

R|1|D^AB_IGG\Yes^AB_37C\Yes|||||||F|||||  

R|2|C^AB_IGM\Yes|||||||F|||||  

R|99|^^^^^|D^C||^|||F||||  
L|1|N

The file contains, after the usual ASTM fields identifying the sample and the patient:

Detailed information for the first antibody
Detailed information for the second antibody
A summary of the antibodies in mix (D and C in the above example)

4. Hints for antibodies weak and in mix

You may get hints about the current situation for the most common cases of weak antibodies and antibodies in
complex mixes by clicking the Hints button.

Figure 8.17. Hints for weak antibodies and mixes

In the listbox at the top left it is possible to select:

• Hints for antibodies in selected mix

• Hints for antibodies covered in Coombs

• Hints for antibodies covered at 37°C

• Hints for antibodies covered at room temperature

5. Getting an explanation for results

To obtain an explanation of the reasons why Resolvigen 4 suggested a given mix, select the mix in the list and
click the Explain button.

Resolvigen 4 will show a list of the panels used for the test; in each panel annotations are added; in the parts with
the antigenic profile the antigens targeted by the excluded antibodies are crossed out.
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Figure 8.18. Explaining results: RBCs antigenic profiles

RBCs that have a weak expression of the antigens are crossed in blue, while RBCs that have a normal or strong
expression are crossed red. The antigen itself is crossed red if at least one non reactive RBCs has a strong expression
for the antigen, blue otherwise.

Antigens that are present in the mix are tagged with different colors; the antigenic expression on each RBC is
tagged with the same color, which is rendered brighter for stronger expressions.

Figure 8.19. Explaining results: scores of reactivity

In the results part positive reactions which are expected to be due to an antibody are tagged with the color of the
target antigen. Again, brighter colors are used for stronger reactions; the tag for a given antigen may be dark in a
strongly reacting RBCs because the strong reaction may be due to antibodies targeting a different antigen.
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Chapter 9. Editing antigenic profile
and reactivities
Resolvigen 4 shows antigenic profiles and reactivities in the common format used when panels are printed on
paper.

Figure 9.1. An antigram edit window

If the window displaying the panel is too small to fit the panel, horizontal and vertical scrollbars are displayed on
the bottom and right border of the panel: use them to display the relevant part of the panel. Alternatively click on
the panel to make sure it has the input focus (the cell of the antigram that has the focus is highlighted in blue) and
use the arrow keys to move to the relevant field: the antigram will scroll as needed.

Editing works differently for different fields. Note that depending on the RBC being part of a panel, an archive
RBC or patient's RBC, some part of the panel may be non editable.

If you PC screen has a resolution of 1024x768 or below, you may wish to display the panel so that
the left part, with RBCs IDs and Rh, and the right part, with scores are fixed and the central part
scrolls. In this case open the configuration page selecting +File → Configure, navigate to the User
options tab and select the Set for small monitor option.

1. Editing the Rh-hr Field

To edit an Rh-hr field, move the focus to it using the arrow keys and press spacebar or double click on it with the
left mouse button. Resolvigen 4 will display a dialog box with two lists for the first and second triplet of the Rh
haplotype. Select one item in each list and click the OK button to confirm or the Cancel button to abort editing.
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Figure 9.2. Editing the Rh haplotypes

If you wish to delete the current haplotype without selecting a different one (e.g. the haplotype is unknown), click
the Unknown button.

When an haplotype is selected, Resolvigen 4 sets the expression for the related antigens accordingly. The expres-
sion of the following antigens is set: D, C, E, c, e, f and Cw. Manually changing the expression for any of these
antigens will clear the Rh-hr field.

2. Editing Donor Number
To edit the donor number field, move the focus to it using the arrow keys or click on it with the left mouse button,
then type the new value.

Figure 9.3. Editing donor's number

While typing you can move the I-beam cursor using the left and right arrow keys; press Enter to confirm the new
value or Escape (Esc) to abort editing. If you need to edit an old value, double click on the donor number cell: an
I-beam cursor will be displayed within the field; you can then proceed editing as above.

3. Editing Antigenic Profile
To change the expression for an antigen, move the focus to it using the arrow keys or click on it with the left
mouse button, then type:

• Spacebar or '?' to clear the expression

• '0' (zero) to set the expression to 0

• 'W' to set expression to +w (weak)
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• '+' to set the expression to +

• 'S' to set the expression to +s (strong)

Figure 9.4. Editing the antigenic profile

If you type any different character or double click with the left mouse button, Resolvigen 4 will display a list of
possible values: press Escape or click somewhere else with the mouse to dismiss the list or select a new value by
clicking on it with the left mouse button or by moving to it with the up and down arrow keys and pressing Enter.

Changing the antigenic expression for any Rh-hr haplotype related antigen (D, C, E, c, e, f and Cw)
will clear the Rh-hr field.

4. Editing the Extended Antigenic Profile

With few exceptions, antigens which have high or low frequency are not displayed in the antigenic profile cells
directly.

To change the expression for one of these antigens move the focus to the Special antigen typing field at the right
of antigenic profile fields using the arrow keys and press space or double click on it with the left mouse button.

Resolvigen 4 will display a dialog box with a list of the antigenic systems on the left and a list of antigens for
the selected system on the right. Both lists may be scrolled using the scrollbar on the right to display more items
if available.

Select the antigenic system on the left, then select the expression for the antigens whose expression is known on
the right. For each antigen a drop-down list is displayed: click on it and select the appropriate value.
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Figure 9.5. Editing the extended antigenic profile

When you have finished editing click the OK button to confirm or the Cancel button to cancel editing.

The Special antigen typing field will display a summary of the extended antigenic profile:

• Missing high frequency antigens are shown; e.g. JMH-.

• '*' means that some extended antigen is set that does not deserve a better description; e.g. a high frequency
antigen has been marked with '+'.

• '...' means that more information is available that does not fit the extended antigen typing field.

The Extended antigen typing dialog also allows editing expression for antigens that are displayed in the normal
antigenic profile part; if a value is edited in the dialog, the value is updated in the normal antigenic profile part
and vice versa.

Changing the antigenic expression for any Rh-hr haplotype related antigen (D, C, E, c, e, f and Cw)
will clear the Rh-hr field.

5. Editing Reactivities
To enter results for test the reactivities of each RBC with patient's serum must be entered in different phases:

Table 9.1. The different test phases

RT The test has been performed at Room Temperature

37 The test has been performed at 37 ºC

C The test has been performed with antiglobulin serum: anti-IgG + C3d

RTE The test has been performed at Room Temperature; RBCs have been pre-treated with enzymes
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37E The test has been performed at 37 ºC; RBCs have been pre-treated with enzymes

CE The test has been performed with antiglobulin serum: anti-IgG + C3d; RBCs have been pre-treated
with enzymes

IgG The test has been performed with mono-specific anti-IgG (without C3d) antiglobulin serum

To change the expression for a reactivity, move the focus to it using the arrow keys or click on it with the left
mouse button, then type:

• Spacebar or '?' to clear the reactivity score

• '0' (zero) to set reactivity score to 0

• '-' to set reactivity score to +/- (weak reactivity)

• '+' or '1' to set reactivity score to 1+

• 2 to set reactivity score to 2+

• 3 to set reactivity score to 3+

• 4 to set reactivity score to 4+

• 'E' or 'H' to mark hemolysis

Figure 9.6. Editing the reaction score

If you type any different character or double click with the left mouse button, Resolvigen 4 will display a list of
possible values: press Escape or click somewhere else with the mouse to dismiss the list or select a new value by
clicking on it with the left mouse button or by moving to it with the up and down arrow keys and pressing Enter.



52



53

Chapter 10. Program configuration
To view or edit the Resolvigen 4 configuration, select the Configure item in the File menu. Resolvigen 4 will
display a page with several tabs at the top. Click on the tab related to the subject you wish to browse.

When you are finished browsing configuration parameters, click OK to save changes or Cancel to dismiss this
page without saving changes.

1. The Storage tab
This page contains various settings for storing, indexing, importing and exporting data.

Resolvigen 4 may store data either in external XML files or in fields contained in a database; the checkmark Store
data in external XML files described below is used to control this.

When storing data in external XML files, the database is only used to index files and can be erased and rebuilt
anytime without loss of data; this option is recommended when Resolvigen 4 is used on a single machine with
a local database; if the database gets corrupted, for example when a power failure occurs, the database can be
rebuilt from the XML files.

When storing data in the database, the folders for the XML files are not used; this option is needed when data
must be shared among different machines using Resolvigen 4 and requires a client server database; in this case
the database runs on a server, so data is not corrupted when a failure occurs on the local machine. The use of
mySQL is recommende in this case.

In any case, it is recommended to perform periodic backup; it is easy to perform backups with Re-
solvigen 4, just select +Utilities → Backup; the backup format used by Resolvigen 4 allows restoring
data on systems using different storage configurations (e.g. a backup from a system using a client
server database, may be restored on a system using external XML files)

1.1. Data folders

When Resolvigen 4 data is stored in XML file: each item, be it patient, test, panel or anything that has a row
displayed in Resolvigen 4 main window, has an associated XML file to hold it.

Figure 10.1. The Data folders group

Since all data files have .XML extension (they are all in XML conforming format), files for different object types
must be stored in different folders; so different folders must be set up for:

• Patients

• Panels

• Rare RBCs

• Tests
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• Users

To change the folder set for each of these item types, you can either edit the related field or click the button at its
right and select it in a folder selection window.

The LIS folder is used to export results to the Laboratory Information System; data is exported in ASTM format.

1.2. Database link

Resolvigen 4 needs a database for indexing XML files or for storing data depending on the program configuration.

Figure 10.2. The database link configuration

When Store data in external XML is selected, the first five items in Data folders are enabled and the folders set
in those fields are used for storing data; the database is used only for indexing; in this case a local database is
used and the driver used is H2.

Resolvigen 4 will try to figure out a reasonable directory for storing the database tables, but is is anyway possible
to specify a directory in the Server field. If the directory in the Server field is valid, it will take precedence over
the default set by Resolvigen 4 and the Connection string field will be updated accordingly.

When a local database is used, Login and Password are not normally needed and these fields may be left blank.

When Store data in external XML is NOT selected, the first five items in Data folders are disabled and the folders
set in those fields are not used. In this case a client server database is used and the driver should be set to MySQL.

You should ask to your system administrator to create a resolvigen domain in the database, with a user with rights
to create and destroy tables. The system administrator should provide you with the Server (usually a four numbers
sequence like 192.168.0.1) and the Port (normally 3306 for MySQL).

Login and Password must be set as indicated by the system administrator.

1.3. Default import folder

When you ask Resolvigen 4 to import or export data (e.g. when importing panel antigrams), Resolvigen 4 prompts
you for the folder to use.

Figure 10.3. The default import folder

The value entered here is used as a default.

2. The user options tab
In this page you can select the Language and some other user related preferences.
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Figure 10.4. Selecting the language

The list of available languages is displayed at the top. Select the language you prefer in the list: the flag on the
left should be updated to reflect your settings. The date format will be DD/MM/YYYY for European countries
and MM/DD/YYYY for the USA.

Figure 10.5. Other user options

Patients codes are usually ordered alphabetically, that is '98' comes before '99', but also '100' comes before '98' (be-
cause '1' comes before '9'). If Order by numeric patient's code is set, the natural numerical order is observed.

Antigrams are quite wide for older computer screens, with resolution at 1024x768 and below. In this case, checking
Set for small monitor, it is possible to display the central part, the one with the antigenic expressions, in a scrollable
panel, so that the Rh aplotypes and the reaction scores are visible at the same time on the screen.

3. The Instruments tab

This page is used to manage instruments interfaced to Resolvigen 4. At the top a list of the currently interfaced
instruments is shown.
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Figure 10.6. The Instruments tab

Select an instrument model in the Available instrument types box and click Add to add a new instruments with
default settings.

To modify instruments settings to suit your needs, select it in the list at the top: in the Settings box at the bottom
of the window the current settings are displayed; you can edit the name, which is just used as a label in the
Instruments menu to identify the instrument or click the Edit settings button to modify settings.

The dialog displayed to edit settings depends on the specific instrument. Refer to Chapter 11, Interfacing to in-
struments for further details.

To delete the currently selected instrument click the Remove button at the bottom left of the page.

Resolvigen 4 can receive commands from external programs through a TCP/IP connection; if you need to configure
this option click the TCP/IP button.

Figure 10.7. The TCP/IP Settings tab

Resolvigen 4 displays a window in which the user may enable the TCP/IP server and select the IP port to use.
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It is possible to select which machines are enabled to issue commands; to enable a machine just enter its TCP/IP
address and click Add IP. The value 127.0.0.1 always means 'this machine'.

4. Modules
This page contains a list of keys used to enable different add on modules for Resolvigen 4.

Click Add module button to add another row and enter the module name and key to enable the new module. Select
a module and click the Remove module button to remove it.

Additional modules may be made available in the future.

5. Backup
In this page it is possible to set the default directory used by Resolvigen 4 to perform backups.

Figure 10.8. The backup settings page

If the option Automatic backup when exiting Resolvigen 4 is set, Resolvigen 4 will backup data when exiting.

6. RBCs online
This page is used for setting the service for sharing selected RBC samples in the RBCs archives among different
Resolvigen 4 users. This service has not yet been activated.

7. Email configuration
In this page it is possible to configure the email service used when exporting patients, RBCs or tests by email.

Figure 10.9. The mail configuration page

Ask your system administrator for the configuration required by your email server.

8. System information
This page displays a detailed description of your system; information shown here may be useful to technical
support while helping you.
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Chapter 11. Interfacing to instruments
Resolvigen 4 can import data from different instruments; normally the data received from the instrument just
contain references to identify the context in which the reaction was obtained (RBC used, patient, phase of reaction):
antigenic profile of RBCs is normally not available to the automatic instrument.

If this is the case, antigrams for panels being used must first be imported into Resolvigen 4 archives. These anti-
grams can normally be obtained directly from Ortho Clinical Diagnostics in electronic form. For instruments sup-
porting this function, you will be able to view an image of the tube for the relevant reaction by right clicking on
the related score cell.

1. Autovue (Innova or Vision)
Resolvigen 4 can import screening and identification test results from AutoVue instruments.

1.1. Configuring AutoVue import module

In order to configure AutoVue import module, select the +File → Configure, then select the Instruments tag.

Select Innova or Vision in the Available Instrument Types list and click the Add button. Resolvigen 4 will add
an instrument to the Installed Instruments list; you may edit the instrument name.

Select this new instrument and click the Edit Settings button at the bottom of the window; the AutoVue Config-
uration window will appear; the first tab, Files, will be selected.

Figure 11.1. The Files tab

The following items must be configured:

• Import folder: this should be set to the folder used by AutoVue to export tests files (these files are named
IdentXXXX.XML where XXXX is replaced by four digits). Resolvigen 4 will read files in this directory, import
the tests they contain and delete them.

• Image path: this field and the next one are used to handle different naming conventions between Resolvigen 4
and Autovue environments; leave these fields blank if both applications run on the same PC

• Image path replacement: see Image path.

• Image copy path: depending on your AutoVue configuration, files in Image path directory may be deleted
after some time. If you specify a path in Image copy path a copy of the images of the imported cassettes will
be stored here.
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If Resolvigen 4 and AutoVue run on different machines, you will most likely need to edit the Image path and the
Image path replacement fields. This may be made clear with an example.

If files are stored inside C:\OCD\AV2G\Resolvigen\Images on the PC running AutoVue and directory C:\OCD
\AV2G\Resolvigen is mapped to X:\ on the PC running Resolvigen 4, just set:

• Image path to C:\OCD\AV2G\Resolvigen

• Image path replacement to X:\

This way, when the file C:\OCD\AV2G\Resolvigen\Images\22065488_001.jpg is required, Resolvigen 4 will
actually search for X:\Images\2065488_001.jpg.

The next three pages, Panels, Panel codes and Programs, contain information needed to import tests; if this
information is missing or incomplete when importing tests, Resolvigen 4 will prompt you for the needed pieces
of information.

Although it is possible to configure the following pages before importing data from AutoVue, it is
recommended to avoid doing this: Resolvigen 4 will prompt you for all the required information
when importing from the AutoVue and most fields will be pre-filled with the data received from
the AutoVue.

The second tab, Panels, contains information needed to match the barcodes read by AutoVue with the panels
stored in Resolvigen 4 archives.

Figure 11.2. The Panels tab

To add a new entry, click Add Panel; Resolvigen 4 will display a window in which you can enter the barcode
and select the matching panel.

For deleting or editing an entry, select it in the table and click the Delete Panel or the Edit Panel button.

The third tab, Panel types, describes the correspondence between the names used by AutoVue and the names
used by Resolvigen 4 to identify panel types.
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Figure 11.3. The Panel types tab

The fourth tab, Programs, contains informations needed to match different parts of imported tests with different
test phases.

Figure 11.4. The Programs tab

To add a new entry, click Add Program; Resolvigen 4 will display a window in which you can enter the program
name and select the matching phase.

1.2. Importing from AutoVue

In order to import data from an AutoVue, select it from the Instruments menu.

Normally Resolvigen 4 will complete importing data in a few seconds; if some information is missing Resolvigen 4
will prompt the user. If, for example a new panel is being used, Resolvigen 4 will prompt the user with the barcode
found by AutoVue and ask the user to select the matching panel in the archives.

If the panel you need has not been imported yet, click the Import new panels button and follow the standard
procedure for importing panels into Resolvigen 4.

The first few times that the import utility is used, Resolvigen 4 will probably encounter new types of AutoVue
programs; in this case Resolvigen 4 will prompt the user for the matching panel phase.

If everything goes fine the new tests will be imported, and a new icon will appear in the toolbar.



Importing from AutoVue

62

Figure 11.5. Imported data available icon

Click on it to browse a list of recently imported tests.

Select the test you wish to view and click OK.

Imported tests are added to Tests archive; select the Tests page to view them.

The Patients will not be imported immediately, but as soon as you double click the test line to view tests, Resolvi-
gen 4 will check for the corresponding patient in Patients' archive.

When images for a given test are available, you may view them by clicking with the right mouse button on the
field in the antigram matching the reaction phase and test RBC.

Figure 11.6. The BioVue window
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Chapter 12. Access and security
settings
When Resolvigen 4 is first installed. two users are defined:

• guest: if enabled, this user may login without password; if guest login is enabled, the login dialog is not displayed
at program startup. In any case, it is still possible to login as a different user.

• root: this user has full privileges to assign and revoke accesses to other users and to set security preferences
for Resolvigen 4; even if you are the only user of your Resolvigen 4 software, you should avoid to access the
system as root for routine operation and also to leave the system unattended when you are logged in as root: a
malicious user could tamper with your security settings and make the hardware protection key unusable.

More users can be added, but these two predefined users cannot be edited or deleted; it is nevertheless possible
to forbid access to the guest user.

User names are case sensitive, so Guest, GUEST and guest are different users.

1. Logging into Resolvigen 4

To change the currently logged user, double click on the user name in the bottom right corner of Resolvigen 4
window or select +Access → Change user.

Figure 12.1. The login dialog

A login dialog will appear: select a user in the User listbox and type the user password in the Password field,
then click OK.

If guest login is allowed, you may leave the User and Password fields blank and click OK.

As soon as this dialog is displayed, the previous user is logged out, so it is not possible to simply
dismiss the dialog and continue with the previous user; short of logging as a new user, the only other
possibility is clicking the Exit Resolvigen now button to exit Resolvigen 4.

2. Managing accesses to Resolvigen

To edit the list of current users, select +Access → Edit users; Resolvigen 4 will display a list of the already
defined users.
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Figure 12.2. The users' window

Double click on one user or select it and click the Edit button to display all the details for that user.

Figure 12.3. The user's details window

If the user being edited is the same as the user currently logged in, it is possible to change the password; to do this:

1. Enter the old password in the Old password field.
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2. Enter the new password in the New password field

3. Retype the same password in the Retype password field.

4. Click the Change password button; if the password is accepted, this button will become green, otherwise it
will become red.

When the root user is logged in, all field are editable; further, the Add and Delete buttons are enabled
so that it is possible to add new users and delete existing users. Note that the root user does not need
to enter the old password in order to set the new password.

3. Configuring security setup
Only the root user is allowed to change the security setup; login as root to access the security setup
window.

Select +Access → Change security setup to display the Security Setup window.

Figure 12.4. The Security Setup window

Change root password

The root password is the password for the root user; for security reasons this password is recorded in the hardware
protection key.

To change this password:

1. Enter the old password in the Password field in the Access section.
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2. Enter the new password in the New password field in the Access data section.

3. Enter the new password again in the Retype new field in the Access data section.

4. Click the Change button in the Access data section.

The new password is now effective.

Change data protection code

The data protection code is used to encrypt the user passwords when they are stored in the Resolvigen 4 database.

To change the data protection code:

1. Enter the current password in the Password field in the Access section.

2. Enter the new data protection code in the Code field in the Data protection section.

3. Enter the new data protection code again in the Retype code field in the Data protection section.

4. Click the Change button in the Data protection section.

The new data protection code is now effective.

Changing the data protection code, invalidates the passwords of all users.

Change login requirements

It is possible to request that only authorized users can login into the program and edit data; four options control
access to the program:

• Require login for user access: if this option is checked a login with a valid account is required when starting
Resolvigen 4; in this case the guest account is disabled.

• Identify user editing patient's data: if this option is selected, Resolvigen 4 will ask the user to confirm his
login credentials when trying to save data for a patient.

• Identify user editing RBC data: if this option is selected, Resolvigen 4 will ask the user to confirm his login
credentials when trying to save data for an RBC sample.

• Identify used editing test data: if this option is selected, Resolvigen 4 will ask the user to confirm his login
credentials when trying to save data for a Test; Resolvigen will also ask the user to confirm his credentials when
exporting Results to LIS (Laboratory Information System).

To change these options:

1. Enter the current password in the Password field in the Access section.

2. Set the desired options in the Options section.

3. Click the Change button in the Options section.

The new options will be effective immediately.

The login name of the user that has edited some data is recorded in the Resolvigen 4 archives.
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4. Managing digital signature certificates
Only the root user is allowed to change the security setup; login as root to access the security setup
window from which you will be able to access the Digital Signature Certificates window.

Select +Access → Change security setup to display the Security Setup window; at the bottom of this window,
click the Certificates button to display the Certificates window.

Figure 12.5. The Certificates window

A list of the available certificates is displayed at the top; select one of these certificates to display full details in
the lower part of the window.

From time to time new certificates are required to validate the new panels; you should obtain new certificates
through Ortho Clinical Diagnostics; to import these certificates, that should come in a PKCS7 format file (normally
with extension .p7b) click the Add certificates button.

Verifying digital signature certificates in conformance to current standards requires checking Certifi-
cate Revocation Lists (aka CRLs) online. To do this, your computer must be connected to the Internet
during the signature verification process. In order to avoid such strict requirements, Resolvigen 4
does not check CRLs, making digital signature verification somewhat less secure, but more practical.
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